### Revision History

<table>
<thead>
<tr>
<th>Version</th>
<th>Status</th>
<th>Date</th>
<th>Update Summary</th>
<th>By</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Draft</td>
<td>21Sep11</td>
<td>Initial version</td>
<td>Julie Dennis</td>
</tr>
<tr>
<td>1.1</td>
<td>Final</td>
<td>10Nov 11</td>
<td>Inclusion of TRAM and SW plus</td>
<td>Julie Dennis</td>
</tr>
<tr>
<td>1.2</td>
<td>Draft Changes</td>
<td>June 2012</td>
<td>Updates</td>
<td>Sandra Brinkley</td>
</tr>
<tr>
<td>1.3</td>
<td>Final</td>
<td>July 2012</td>
<td>Inclusion of v2.2 updates Travelport Smartpoint app</td>
<td>Sandra Brinkley</td>
</tr>
<tr>
<td>1.4</td>
<td>Final</td>
<td>Dec 2012</td>
<td>Updates for v2.3</td>
<td>Julie Dennis/Sandra Brinkley</td>
</tr>
</tbody>
</table>
# Table of Contents

Overview .......................................................................................................................... 7

Product Information ........................................................................................................... 7

Product Installation ............................................................................................................ 7

Main features ...................................................................................................................... 8

Increase Productivity ......................................................................................................... 8

Language Translations ...................................................................................................... 8

Starting Travelport Smartpoint App™ ............................................................................... 9

Window Layout .................................................................................................................. 10

Signing Back In To Smartpoint .......................................................................................... 11

Closing Travelport Smartpoint App™ ................................................................................ 12

Terminal Window .............................................................................................................. 13

Menu Bar ............................................................................................................................ 14

Application Settings ......................................................................................................... 15

Terminal .............................................................................................................................. 16

History ................................................................................................................................. 16

Window ................................................................................................................................ 16

PNR ...................................................................................................................................... 17

Search ................................................................................................................................. 17

SmartPanel .......................................................................................................................... 17

Basic Tab ............................................................................................................................. 18

Passenger Tab ...................................................................................................................... 19

Advanced Tab .................................................................................................................... 19

The Results .......................................................................................................................... 19

Tools ................................................................................................................................... 21

Quick Commands ............................................................................................................. 23

Relay .................................................................................................................................. 25

Queue Count Options ........................................................................................................ 29

Queue Count Pop-up Panel ............................................................................................... 31

Queue Count Pop-up Panel Display ................................................................................... 31

Replay Entries .................................................................................................................... 32

Replay PNR’s ...................................................................................................................... 32

Calendar Options ............................................................................................................... 33
Language Translations ................................................................................................................. 37
Keyboard Mapping ......................................................................................................................... 38
Terminal Window .......................................................................................................................... 39
Terminal Window Partitions .......................................................................................................... 39
Terminal Window Tabs .................................................................................................................. 40
Terminal Window Work Areas ....................................................................................................... 40
PNR Viewer Window ..................................................................................................................... 41
Quick Access Buttons in PNR Viewer .......................................................................................... 41
Configuring Quick Access Buttons ............................................................................................. 42
Find ................................................................................................................................................ 42
PNR Viewer Display Modes .......................................................................................................... 43
Zoom ............................................................................................................................................. 43
Replay PNR’s ................................................................................................................................. 43
Edit PNR’s ...................................................................................................................................... 44
Print ................................................................................................................................................ 44
Refresh .......................................................................................................................................... 44
Air Availability ................................................................................................................................ 45
Prior/Next Day Search .................................................................................................................. 45
Outbound/Return Availability ....................................................................................................... 46
Selling from Air Availability ......................................................................................................... 46
Fare Shopping search using Smartpoint ......................................................................................... 46
Fare Quote and Fare Quote Best Buy .............................................................................................. 47
Fare and Tariff displays using Smartpoint ..................................................................................... 48
Display Fare Rules from a filed fare .............................................................................................. 49
Low Cost Carriers ........................................................................................................................ 50
Hotel Availability and Booking ..................................................................................................... 54
Hotel Images .................................................................................................................................. 57
Car Availability and Booking ......................................................................................................... 58
Retrieve Booking ............................................................................................................................ 62
Client PRO-files ............................................................................................................................. 62
Client File ...................................................................................................................................... 62
Travelscreen Preferencing ............................................................................................................. 63
Troubleshooting ............................................................................................................................. 68
Overview

Travelport Smartpoint App™ has been created as an add-on application for Galileo Desktop™ that infuses the cryptic environment with a hybrid of native and point and click navigation, plus graphical user interfaces designed to speed up the booking process, reduce call handling time and improve the user experience.

Smartpoint effectively reduces keystrokes, contributes to increased efficiencies and speeds up the agent booking process.

Travelport Smartpoint App™ is an example of how the technology of an XML API Desktop product can be integrated with the Galileo Desktop platform to supplement cryptic and point and click navigation with graphical user interfaces and to seamlessly guide an agent through the booking process. Smartpoint supports both Galileo and Apollo core systems and allows agents to work on both systems using either system language.

Travelport Smartpoint App™ further improves and streamlines point & click navigation and allows the agent to enter either Galileo or Apollo terminal emulation transaction commands (i.e. formats) to invoke any GDS function, returning highlighted items (an interactive response) that the user can click on to transmit core transactions to book and complete a reservation.

Product Information

Product Installation

Technical Requirements:

Desktop users:

Galileo Desktop 2.4 and above is required to be able to install Travelport Smartpoint App™

Smartpoint App uses Microsoft .NET 4.0.

Windows XP Service Pack 3 or above.

Smartpoint App has been successfully tested on PCs with 512MB RAM, however 1GB is recommended.

Performance is going to be based on RAM and CPU speed. It has been tested successfully (so it works well) on a Pentium IV 1.8GHz. Most of the modern hardware is using Core Duo processors or above (for last 3 years).

Smartpoint App supports GPU Acceleration too.
Main features
Here are some of the main features provided:

- Cryptic Language Translation capability for Amadeus, Sabre, Abacus and Worldspan GDS’s
- Automatic redisplay of booking file
- Follow up transactions accessible with a click
- Intuitive point and click approach to booking hotels and cars
- Quick reservation process reducing keystrokes by up 70%
- Access to last seat availability from the initial display
- Outbound and return availability using a single transaction
- Shopping results sorted by price or departure time
- Aggregated and surcharge inclusive shopping
- Effective queue management
- Smartpanel – for advanced shopping – new v2.3 2012

Increase Productivity
As well as the above Travelport Smartpoint App™ allows agents to focus on improving non-air attachment rates. By making car and hotel reservations easier for the agent, it could significantly increase attachment rates and subsequently increase revenue and profitability. Productivity gains can be obtained by quicker reservations with fewer errors.

- Limited cryptic entry knowledge needed so less training time – translation capability allows an agent to work across multiple GDS’s in the language they are familiar with.
- Experienced users retain control of their workspace via cryptic entries
- Full set of cryptic transactions, keyboard navigation control and shortcuts
- Multiple Window Support, Multi-Tab, dual Terminal per Tab
- Quick Commands to customize own formats

Language Translations
An important and useful feature of Travelport Smartpoint App™ is the ability to use the tool as a transition and conversion instrument. During the process of changing a non-Travelport GDS to the Galileo/Apollo system, Travelport Smartpoint App™ eases the transition and migration efforts by providing a translation application for Sabre, Amadeus, Worldspan or Abacus into Galileo or Apollo entries can then be translated into either the primary GDS (Apollo or Galileo) or secondary GDS (Sabre, Amadeus, Worldspan, Abacus, Galileo or Apollo) languages.
Starting Travelport Smartpoint App™
Travelport Smartpoint App™ is automatically launched when Galileo Desktop is opened.

The action of signing onto Travelport Smartpoint App™ will also sign the user into Galileo Desktop™

By default Travelport Smartpoint App™ provides of the following:

- The **Terminal Window** to enter formats and obtain general responses
- The **PNR Viewer** a window that automatically refreshes the Booking File
- When you select CTRL+F12 you will still see the sign on box for Galileo Desktop.

Please select cancel and then select Terminals to work on Galileo Desktop or select one of the other buttons to work in Viewpoint.
If Travelport Smartpoint App™ has been closed it can be re-launched by clicking the Travelport Smartpoint App™ icon. Visible in the Galileo Desktop Custom Toolbar. Upon successful installation of Travelport Smartpoint App™ this icon will be automatically installed onto the toolbar.

Window Layout

Travelport Smartpoint App™ supports multiple Terminal Windows that can be configured independently. For example, a terminal window can have its own font settings or use a different Client IDs or connection to a different host if needed. The layout defined by the user can be saved so that Travelport Smartpoint App™ uses the saved layout each time the App is launched.
By default, the Travelport Smartpoint App™ window layout is composed of two basic windows, the Terminal Window and the PNR Viewer. The Terminal window permits to input formats easily by means of the command line on top and to obtain outputs to interact according to functional needs. The PNR Viewer window constantly updates the active Booking File in the work area.

If the “Embed Smartpoint in Galileo Desktop” option is selected the user will need to press CTRL + F12 simultaneously to close Travelport Smartpoint App™ to see other Applications on the Desktop, if this option is not selected, the user can move each window of Travelport Smartpoint App™ independently.

**Please note Galileo Desktop must be open in order for Travelport Smartpoint App™ to work**

### Signing Back In To Smartpoint

Upon launch of Travelport Smartpoint App™, if the user is not signed into Galileo Desktop™, a sign-on dialog box will be displayed. The user should key in their Galileo Desktop™ sign on and password here.

**Note: SON/ should be removed from the user sign on**

![Smartpoint Sign-on Dialog](image)

For Client IDs which require emulation, another box will be launched to indicate the corresponding PCC if needed. **Cancel** must be clicked not to emulate.
Closing Travelport Smartpoint App™

To hide the Travelport Smartpoint App™ and return to Galileo Desktop you can enter Ctrl+F12, using Ctrl+F12 will also bring Travelport Smartpoint App™ back to the forefront. **We would recommend that if you are using Travelport Smartpoint App™ not to build any PKeys using the Ctrl+F12 function.**
Terminal Window

Travelport Smartpoint App™ supports multiple terminal windows that can be configured independently. For example, a terminal window can have its own font settings or use a different connection to a different host if needed. The layout defined by the user can be saved so that Travelport Smartpoint App™ uses it each time upon start up. (For more details, see section - Application Menu).

The following screenshot shows how a Terminal Window is structured:
- **Application Menu**: provides access to terminal and window configuration options, history options and access to the Smartpoint tools (see section - Application Menu)
- **Terminal Window Tabs**: support for multiple Tabs
- **Status Area**: activity indicator
- **Queue Control Buttons**: clicking on icons initiate a Queue function
- **Replay Icon**: initiates replay functionality. Terminal entries are captured and can be replayed by simply selecting entry and sending
- **Terminal Window Work Areas**: highlights active work area and allows agent to click back and forth within the 5 work areas
- **Translation Icon**: indicates primary language and initiates translation pop-up functions
- **Plugins ON/OFF**: Turns off the clickable functionality in Smartpoint
- **Quick Commands Tool Bar**: Tool bar for Quick Commands
- **View Switch**: controls terminal window partitions
- **Connection Switcher**: used to select available connections in Galileo Desktop
- **Smartpanel**: Opens up the shopping panel
- **Window Control Buttons**: this area controls 4 functions:
  - Copy Function: The first icon controls different copy actions: “Take a window snapshot”, “Copy content as Image” and “Copy content as Text” and “Print this Window”
  - Maximize/Restore: maximize or restore the window
  - Close: close the selected window only

**Menu Bar**

The Main **Menu Bar** drop down is composed of 8 elements: Application, Terminal, History, Window, PNR, Search, Tools and Help.

![Menu Bar](image)

Some menu items show a keyboard shortcut that can be used instead; this is implemented in order to provide an alternative to using the mouse.

![Menu Bar](image)
From this drop-down the agent can customize the appearance of the Terminal Window

Application Settings

The Application Settings drop-down menu enables the user to customize display options including language, theme and colour scheme, additionally a user can create additional windows and change font type and font size.

The “Embed Smartpoint to Galileo Desktop” option, if selected, allows the user to move the screen

In order to change the settings, the agent must select Save for the changes to take effect.
Terminal

This menu option allows the agent to manipulate the Terminal Window Tab functionality. Add a new terminal window, or delete a Window, Copy Information in the selected Window.

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Setting</th>
<th>Window</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Terminal</td>
<td>Add New</td>
<td>Window Options</td>
<td>Add Window</td>
</tr>
<tr>
<td>Close Window</td>
<td>Close Window</td>
<td>Close All Windows</td>
<td>Close All Windows</td>
</tr>
<tr>
<td>Copy Terminal Contents</td>
<td>Copy App Contents</td>
<td>Copy Window</td>
<td>Copy Window</td>
</tr>
</tbody>
</table>

**Response history can be retrieved for up to 5 previous responses**

History

This menu option allows the agent to review the terminal responses that have been displayed. Terminal Window Tab functionality.

**Response history can be retrieved for up to 5 previous responses**

Window

This drop-down menu allows the agent to switch between the Terminal Window and the PNR/Booking File Viewer window.
PNR

This drop-down menu allows the agent to open dialog boxes that will help to create or edit a Booking File/PNR. It also enables the user to launch the Replay PNR functionality.

Search

This drop-down menu allows the agent to open a pop up box to search, Air, Hotel, Cars and Fare Shopping. From this menu you can also launch Smart Panel a GUI for Fare Shopping.

SmartPanel

Smart Panel is a component of Travelport Smartpoint App™. Smart Panel applies pre-set parameters, such as classes of service, departure time windows, account code, etc. via a fill-in-format to perform a fares-led search.

Smart Panel contains three tabs: Basic, Passengers, and Advanced.

To launch Smart Panel in Travelport Smartpoint App™ click on the following icon in the Active Window, and the below pop up box will launch. Or you can launch via the Search menu or by doing #FS.
Basic Tab

Use the Basic tab to enter travel parameters such as the departure and destination points and outbound and return travel dates.

In the Save As field, enter the name of the template you wish to save. Select the Set as Default checkbox to save the template as the default.

You do not need to reset templates on each search unless you want to.

Note: You cannot save templates on a per corporate client basis.
Passenger Tab

Within this TAB you can

1. Add your passengers names
2. Add additional passengers
3. Add the Passengers to the PNR/Booking File
4. Refresh Smart Panel

Advanced Tab

Within the Advanced TAB you can customize your fare search, by clicking on the radio buttons in the tab, for example only ask for non-stop flights with a specific account code.

The Results

When you click the Search button, a fares-led search results appear in the Smartpoint App window. Results can include one way, round trip, and circle trip options with a maximum of 8 destinations. All applicable flight and fare combinations appear.
Example

You would follow the same steps as normal to then book and confirm your ticket.

Smart Panel can also processes round trips using one way pricing. To request a round trip using one way pricing, select the Process as two one ways checkbox and click the Search button.

Two one way searches appear in the divided Smartpoint App window.

Example

After you click the <<BOOK>> link for each one-way pricing option, Smartpoint stores the fares as two one ways.
Tools

This drop-down menu allows the agent to access Queue Count Options, Replay entries and the calendar tool option.

Automatic Update Options

ESD - ESD stands for Electronic Software Distribution and refers to the automatic push of new versions of Travelport Smartpoint App™

Within Smartpoint we have now created the ability to auto push a new release. You will within the Alpha of Smartpoint see a pop up that will advise you that there is a new version of Smartpoint. You can also ask Smartpoint to search to see if there is a newer version available.

Go to tools menu and select Automatic update Options

There is a new plugin called ESD (Electronic Software Distribution) that performs the below two functions.

1. **Automatic Update**: Prompts users when a new version of Smartpoint is available for download.
2. **Usage Statistics**: Uploads usage statistics showing how each user is using Smartpoint.

ESD Automatic Update

The ESD plugin checks to see if the user is running the latest version of Smartpoint. If a later version is available then the user sees the below pop-up message (messages are translated to the Smartpoint supported languages)
Users can also choose to manually check if they are running the latest version. This is done by going to the Tools menu and selecting Automatic Update Options.

The Product strategy is to have as many users as possible using this plugin to automatically update their Smartpoint version. However, the plugin is not suitable for shared user environments like Citrix. Customers who use Citrix should be directed to the Citrix Installation Guide.

The **timings** for when a user will see pop-up messages are as follows:

**Check for updates:** Every 21 Days

The user can postpone the update for 30 Days

The Auto push will remind the user every 21 days that a new version of Travelport Smartpoint App™ is available to download.

In summary, the timings are the same for all users and cannot be changed without pushing a new version of Smartpoint to all users.

The version check is randomised over a 21 day period so that all users do not upgrade on the same day. After the 1st pop-up message the users will be reminded every 21 days. The time of the day is also randomised over a 7 hour window from when Smartpoint is started so that users downloading on the same day do so at different times.
Should the version check time be at a time when the user has closed Smartpoint then the check will happen on the next day.

If the user’s version of Smartpoint is older than the **minimum supported version** set by Product then the user will be forced to upgrade or exit Smartpoint (and Galileo Desktop). Typically support is provided for the current version and the previous version of any given Product. That being the case, and based on a 6 monthly major Smartpoint release cycle, a user would need to defer the upgrade (click the Not now button) for 6 months before being forced to upgrade.

**Quick Commands**

A new Quick Commands™ option has been enabled in Travelport Smartpoint App™ in order to allow users to launch browser window content, executable applications or Viewpoint dialogs by three very simple means:

- A configurable menu item inside Tools/Quick Commands™ main menu item

![Quick Commands Menu Item](image1)

- A clickable button in a new panel that will pop-up when hovering the ‘Q’ button in the Terminal control

![Quick Commands Button](image2)
- Through a quick Terminal Command which will begin with a # and that is completely defined by the user (i.e. for Notepad will be #NP by default).

A new Quick Commands Configuration dialog allows creation, modification or deletion of Quick Commands in Travelport Smartpoint App™. The user is able to define the name, the type of resource, the terminal command and if also generate an item menu and/or a personalized button.

How to create a Quick Command

1. Launch the Quick Command dialog box
2. Click on Add
   - Name your Command
   - Select the type of request
     1. Viewpoint Com Box – Selecting this will launch a Viewpoint dialog Box
     2. URL – Selecting this will launch a Website
     3. EXE file – Selecting this will launch an executable file
   - Select where you require the Command to launch. You can create both a Menu in the dropdown and a quick access button
   - Here you can request your PNR be refreshed so you’re always working on the most up to date information
3. Click Save

A new ‘Q’ button has been placed on the bottom bar of the Terminal Window clicking on it displays the Quick Commands Configuration Tool Bar.

![Travelport Smartpoint App - Window 1](image)

**Relay**

This enhancement enables Smartpoint to create a Quick Command for any of the following Relay applications previously installed with Galileo Desktop. (Please note this enhancement does not install Relay. Relay must already be installed through Galileo Desktop).

- Itinerary Capture (Apollo Only)
- Queues
- PNR/BF
- ClientFile/Profile
- Ticket Exchange (Apollo or Galileo)
- Recovery
- Rules
- EStatus

During the Smartpoint installation, Smartpoint verifies which Relay applications were previously installed and when one or more application is found, Smartpoint presents an Optional Relay Quick Command section as part of the installation package.

*Example of the optional Relay Quick Commands section that appears in Smartpoint’s installation for a Galileo user. The list contains all Relay applications that have been installed. Each application is checked by default to indicate that a Quick Command and Quick Command button will be created as part of the installation. Uncheck the checkbox next to an application if you do not wish to create a Quick Command and button.*
Apollo users who previously installed Relay's Itinerary Capture will also see this application on the list.

Relay Quick Commands buttons created during the installation of Smartpoint appear under the Quick Commands Tool.
Hover over a quick Command button to view the Quick Command format or click on the button to open the Relay application.

<table>
<thead>
<tr>
<th>Quick Command Format</th>
<th>Relay Application</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>#QUEUES</td>
<td>Queues</td>
<td>Opens Relay’s Queue Manager</td>
</tr>
<tr>
<td>#BF (Galileo) or #PNR (Apollo)</td>
<td>BF Retrieval (Galileo) PNR Retrieval (Apollo)</td>
<td>Launches Relay’s PNR, BF Retrieval pop-up</td>
</tr>
<tr>
<td>#CLIENTFILE (Galileo) or #PROFILE (Apollo)</td>
<td>ClientFile (Galileo) Profile (Apollo)</td>
<td>Opens Relay’s ClientFile or Profile Editor</td>
</tr>
<tr>
<td>#EXCHANGE</td>
<td>(Ticket) Exchange</td>
<td>Opens Relay’s Apollo or Galileo Ticket Exchange (based on host)</td>
</tr>
<tr>
<td>#RECOVERY</td>
<td>Recovery</td>
<td>Opens Relay’s Print Recovery</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>#RULES</td>
<td>Rules</td>
<td>Opens Relay’s Custom Check</td>
</tr>
<tr>
<td></td>
<td></td>
<td>editor</td>
</tr>
<tr>
<td>#ESTATUS</td>
<td>Estatus</td>
<td>Launches Relay’s e-ticket</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pop-up</td>
</tr>
<tr>
<td>#ITINERARYCAPTURE</td>
<td>Itinerary</td>
<td>Launches Relay’s Itinerary</td>
</tr>
<tr>
<td>(Apollo)</td>
<td></td>
<td>Capture pop-up for the Apollo</td>
</tr>
<tr>
<td></td>
<td></td>
<td>user</td>
</tr>
</tbody>
</table>

Once a Relay application is opened through the Quick Command button or format in Smartpoint, the Relay application behaves the same as opening the application through Galileo Desktop.

### Response Capture

Smartpoint does not create a Quick Command format or button for Relay’s Response Capture. The ability to capture any response is available by clicking the Windows button at the top right corner of the PNR Viewer or Terminal Window.
When clicking on the Windows button in the PNR Viewer, and Copy as Text is selected, all content in the PNR/BF is captured to the clipboard so that it can be pasted into another application (Notepad, Word, and Email)

When Clicking on the Windows button in the Terminal Window, all information in that window is also copied so it can be pasted into another application,

**Queue Count Options**

Selected the Queue Count Option from the Tools menu, the screen below will be displayed allowing the user to a maximum of ten QuickView Queues or a queue category within a specific queue. It is possible to select three of these queues/queue categories as being visible. It is also possible to determine the frequency in minutes of the polling of these queues, the minimum poling is 15 minutes. Display queue change notifications. This determines if new notifications are shown that indicate which queues have an increase in PNRs/ Booking Files, and what the increase is (described further below). This checkbox will be checked by default. Once set these queue count options will remain until the Queue Count Options are subsequently changed.

Once saved the queue is highlighted at the bottom of the screen, initially in a red ‘bubble’ with the total number of Booking Files that are on each queue displayed within their ‘bubble’.
Moving the cursor over a red ‘bubble’, Booking Files that on queue will be displayed in a separate window (shown below).

From here the record locator from within the queue can be clicked which will take the user into the queue and also the booking in the PNR viewer.
Queue Count Pop-up Panel

This new panel allows a user to view existing totals for the 10 queues listed in the Queue Options dialog, including the queues that have not been selected as visible.

A new button/icon has been added to the terminal window status bar just on the left of the queue status bubbles entitled ‘MQ’. Clicking it will display a panel that shows two columns with up to 5 queues each.

Queue Count Pop-up Panel Display

All items are links and their behavior is the same as the links in a QCA response (clicking queue numbers assigns a user into the queue and clicking queue totals results in the equivalent of a QLD/nn response to be shown on the terminal window).

The working the queue can be handled quickly and easily via the buttons now available at the bottom of the active window.

The green arrow will takes the user back to the queue bubbles, the user remains signed into the queue until such a time that they click on the QXI icon.
Replay Entries

Replay Entries will show you the last entries made in Smartpoint

Replay PNR's

This allows users to display a list of PNRs / Booking Files that they have inspected previously, showing the record locator and lead passenger for those bookings. When the user clicks on one item from the list, the PNR/ Booking File will be displayed in the PNR Viewer Window.

How to look at your Bookings

1. Click on Undock
2. Select the PNR you wish to look at, this will show you the first few lines of the PNR/Booking File.
3. Once you have finished click on the Dock button to take you back to the list view.

**Saving a Copy of your booking files**

1. Click on Options

Here you can export a list of PNRS/Booking files to a xaml file.

**Calendar Options**

Open the calendar from Main **Application Menu - Tools – Calendar**

Once open, an option is displayed entitled “open on startup”, selecting the check box will ensure the Travelport Smartpoint App™ calendar will always open on startup unless this box is then unchecked and the configuration saved.

The Smartpoint Calendar is contextual, that means that the user can trigger air availabilities, Focalpoint shopping requests, hotel and cars from the calendar.

In order to do this, first select the date range by clicking on a start date and holding to the end date.
Next **right-click** on that range and a context menu will be shown with the following options:

Lastly the agent can then click on the option that they would like to initiate.

Depending on the option that is selected, an additional option for Origin and Destination may appear.

**How to shop using the Calendar**

- **Availability** – Highlight the dates of requested travel right mouse click and select availability you will see the below pop-up screen appear.
Select the origin and destination (these are the only options that are mandatory), times, number of passengers and the class of travel (in the booking code box) click on search this will give you an availability display on your inputted search criteria

- **Last Air** – This option will allow you to shop the last availability request selected, for example, if you had previously searched LHR – BCN 19 March back the 23 March, by selecting new dates on the calendar and then the Last Air this will shop the same route LHR to BCN but on the new dates requested

- **Shopping** – This feature will allow to Fare Shop via the calendar. Select the dates required for travel, right click and select Shopping, a new pop-up box will appear where you are required to select the route and number of passengers, all other boxes are optional

- **Flight Shopping + Hotels** – This function will allow you to shop for flights and hotels in one smooth transaction
Results

Top screen Air

Bottom Screen Hotels

- Hotels And Cars – This option gives a pop-up box to search for Hotels And Cars

- Main Application Menu ➔ Help

From this drop-down the agent can access the User’s Guide, Ask Travelport and display what version of the Smartpoint App is currently installed.
Calculator

Windows calculator is now accessible from the Tools menu in Smartpoint. Select Tools>Calculator to open it. The Windows calculator remains open until manually closed.

Language Translations

Smartpoint App has a valuable feature that can be used to transition an agent from one GDS system to another. It allows agents to mix and operate with multiple system languages in the same record. This translation feature supports a Primary and Secondary Language and can be configured by clicking on the translation icon.

Or will be shown depending on your primary cryptic language choice.

The following dialog window will display for the agent to setup their system language preferences:
The Travelport Galileo® and Apollo® hosts are the choices available as the primary languages. Galileo, Apollo, Worldspan, Amadeus, Sabre and Abacus are available as the Secondary Cryptic Language options.

**Note**: Travelport Smartpoint App cannot translate *all* entries, this is designed to aid the travel agent in the transition from competitor GDS to Travelport, therefore a limited subset of entries on each GDS system is supported. This capability doesn't mean that the agent won’t need to be trained on either Galileo/Apollo, training is still required

*An up to date list of entries can be found on Ask Travelport under Answer number 36210*

**Keyboard Mapping**

Travelport Smartpoint App™ is designed in such a way that nonstandard keyboards including Sabre keyboard mapping which uses special characters including cross of Lorraine, and also Swiss keyboard can be accommodated. To enable this the user needs to click the Translation icon at the bottom of the screen, depending on their translation setup this may be a 1G or 1V

Select the required keyboard mapping and save the settings

Apollo users are provided with the ability to choose the Apollo keyboard mapping in their Galileo TCP/IP settings accessible in the Control Panel. A user who has selected Apollo mapped keyboard will be able to use special characters including the pillow ([ ]) end item (+), display (*) dollar sign ($) and colon (:). Apollo mapped keyboard users use the! to bypass point and click.
Terminal Window

Terminal Window Partitions

- A Terminal Window can be divided into two terminal partitions (belonging to the same work area); upper and lower. By default, one (the top terminal partition) is shown. Clicking on the View Switch button activates and deactivates the window partition.

- Navigation between the upper and lower partition is accomplished by clicking within the desired partition or by shortcuts Alt + D (lower window=2) or Alt + U (upper window=1).
- Once the partition split line is shown, it can be dragged to adjust the size of the upper/lower terminal partitions.
Terminal Window Tabs

- A Terminal Window can also be divided into “Tabs” (belonging to the same work area). This allows agents to multitask in order to conduct many searches at the same time. The agent can have up to 9 tabs at one time.

![Terminal Window Tabs](image)

- To create a new tab, the agent can select **Main Application Menu → Terminal → New Terminal in Tab** or using the shortcut **Alt + N**. Each tab gets a name which corresponds to the last input entered. In addition, a number indicator is automatically assigned to each tab.

- To navigate to a specific tab, the agent can either click on the tab or use the shortcut **Alt + 1, 2, 3, etc.**

- The tabs can be deleted by clicking on the X next to the tab name or using the shortcut **Alt + R**. It is also possible to remove via **Main Application Menu → Terminal → Remove Current Terminal Tab**.

Terminal Window Work Areas

- ![Work Area Icons](image)

- Like Galileo Desktop, Smartpoint also offers the 5-work-area infrastructure: A, B, C, D and E. The Work Area that is active will be indicated in the lower right corner and highlighted in yellow.

- To navigate between the Work Areas, the agent simply clicks on the appropriate icon. The entries **SA, SB...SE** are still accepted.

- If an agent has more than one Work Area active, when hovering over each Work Area icon, a thumbnail will appear to show the content of the existing PNR/Booking File in that Work Area.
PNR Viewer Window

The PNR Viewer provides an instant view of the PNR/Booking File. It shows all relevant PNR/Booking File information and is grouped in sections that can be accessed via a simple mouse click on the associated Quick Access Button.

Quick Access Buttons in PNR Viewer

Except for passenger names and itinerary, all PNR/Booking File fields can be displayed at any time via the configurable PNR Quick Access blue buttons. Clicking on a Quick Access button will display all of the PNR/Booking File data applicable to that PNR field.
Once a specific field is retrieved, it can be closed by clicking on the same Quick Access button again or by hovering over the data field and clicking the Close button.

Your PNR viewer buttons will pick up what GDS you are using, either Galileo or Apollo.

As an example:

- ![ALL](image) displays the complete PNR/Booking File information with all fields
- ![?](image) displays the Phone Field information

**Configuring Quick Access Buttons**

In the upper right hand corner of the PNR Viewer window is a toolbar that can be used by the agent to refresh the window and to access the Quick Access configuration toolbar and to Print the PNR / Booking File and Edit PNR / Booking File fields.

- ![R](image) Refreshes the PNR VIEWER on every click.
- ![U](image) Shows the Quick Access configuration toolbar.

This toolbar provides some options to configure the sections an agent wants to see when a PNR is displayed in the PNR Viewer window.

**Single View Mode** - by default, name and itinerary are automatically retrieved. Blue buttons must be clicked to retrieve other fields.

**Uncheck Single View Mode** – when configured, the agent can select the PNR fields that will be displayed in an automatic and unhidden mode.

**Show Buttons at Top** - access buttons are displayed at the bottom of the segments section by default; however it can be configured to show at the top of the PNR Viewer.

**Find**

FIND is located in the lower left corner of the PNR Viewer Window. Click the ![FIND](image) to open.
When working with large PNRs/Booking Files, it might be useful to search for a specific word within the current PNR. When found, the words will be highlighted in the PNR Viewer Window.

**PNR Viewer Display Modes**

The PNR Viewer can be configured to show the PNR / Booking File information in three different ways. Clicking on the applicable icon will change the display mode.

- **Single Page:** Agent can navigate through different pages by using .
- **Two Pages:** Data will be shown in two side by side columns.
- **Scroll Mode:** Only one page will be available but a vertical scrollbar will allow the agent to slide up and down the PNR.

**Zoom**

Zoom level in the PNR Viewer can be adjusted in order to fit well in the screen. On some PC configurations the resolution might not be optimal for a clear view of the PNR/ Booking File; therefore agents should change this in order to have the PNR / Booking file width adjusted to the PNR Viewer Window width.

**Replay PNR’s**

This allows users to display a list of PNRs/ booking Files that they have inspected previously, showing the record locator and lead passenger for those bookings. When the user clicks on one item from the list, the PNR / Booking Files will be displayed in a PNR Viewer Window.
Edit PNR's

By clicking on the menu items, you will be able to create or edit parts of the PNR/Booking File in a GUI. For example create/ Edit Customer information

Print

By Clicking in the P in the PNR Viewer Window this will print the current PNR/ Booking File displayed.

Refresh

By Clicking on the R this will refresh the PNR/ Booking File in the PNR Viewer Window
Air Availability

Smartpoint shows **all classes of service offered in a single expanded display**. There is no need to remember complicated follow up entries.

Smartpoint uses standard **Galileo and Apollo entries** to display availability, pricing and ticketing. In addition all main displays are supported by highlighting.

There is no need to remember complicated follow on transactions. Just point and click to sell flights, access airport, terminal, equipment and flight duration information.

Hovering over the following data elements shows:

- **Blue font items**: Performs decode on airport, carrier, codeshare and equipment.
- **Flight Numbers**: Supplies terminal and elapsed flying time information

**More Flights** link: Returns more air availability. **ALT + M** can be entered instead of clicking with the mouse.

⚠ Clicking on the More Flights link does not remove the original 16 flight options. The agent can scroll up and down to view all availability options that have been displayed.

Remember you can add an additional TAB so you can have even more areas to work in. To create a new tab, the agent can select **Main Application Menu → Terminal → New Terminal in Tab** or using the shortcut **Alt + N**. Each tab gets a name which corresponds to the last input entered. In addition, a number indicator is automatically assigned to each tab.

**Prior/Next Day Search**

Dates and number of passengers can be changed after an initial availability is performed via the Availability Modifier toolbar. This allows agents to quickly access the same availability request for the following/prior day or for a different number of passengers – up to nine.
Outbound/Return Availability

Smartpoint enables agents to search for outbound and return flights in a single transaction. In response to such a request, outbound and return availability displays are shown using the upper and lower Terminal Partitions. Agents can book both the outbound and return segments in a single entry or click on the booking class to sell:

Both screens show the Prior/Next Day toolbar to navigate forward or back and select the quantity of passengers.

Outbound/Return Availability is displayed from a single entry using a “++” symbol.

For instance: A16JUNLHRDEN++20JUN

This will display the availability for 16th of June from LHR to DEN on the upper partition and the availability for 20th of June from DEN to LHR on the lower partition.

Selling from Air Availability

To book a segment, the agent simply clicks on the booking class to sell.

In an Outbound/Return Availability, the agent would click on a booking class from the top partition for an outbound segment and then click on a booking class from the bottom partition for a return segment.

Cryptic formats can also be entered to book such as 01Y1 for Apollo or N1Y1 Galileo. Outbound and Return flights would be 01Y1++01Y4 or N1Y1++N1Y4.

Segment sell responses are displayed underneath the new segment in the PNR Viewer. If the segment sell is unsuccessful, then it still displays this in the Terminal Window.

Classes of service will display in different colors depending on their availability:

- Booking classes in Green: books confirmed.
- Booking classes in Orange: books on waitlist
- Booking classes in Grey: space is not available.

Fare Shopping search using Smartpoint

Searching for lower fares using Smartpoint provides a 70% reduction in keystrokes. Agents can access valuable information with a single click.
Using a simple transaction format FSLHR16JULDEN20JULLHR, customers have access to the broadest choice of any low fares search and pricing system in the industry. Travelport e-Pricing™ technology now powers all fare searches and pricing requests.

All result options can be ordered by price, departure time and journey time.

There are some quick links available that provide the following functionality:

- **Book**: books the selected itinerary.
- **Details**: provides more details about this itinerary and its fares.
- **Rules**: provides detailed information about the fare rules.
- **More*n**: allows the agent to see more itineraries that meet the selected fare.

**Fare Quote and Fare Quote Best Buy**

The fare quote response has been enhanced to offer a quick way to check rules.

- Just FQ, FQBB or FQBC can analyze fare categories easily for Galileo
- Just $B, $BB or $BBC can analyze fare categories easily for Apollo
- DISPLAY RULES is the gateway. Then, each fare basis participating in the quotation for each fare component can be accessed to display the complete fare rule text.
- A simple click on the city pair is required to read only category 16 for penalties.
Fare and Tariff displays using Smartpoint

Smartpoint offers a fantastic environment to request fares for city pairs and to check details and rules.

Apart from the current information supplied by Focalpoint, there are many clickable items with follow-up material to complete the whole fare investigation process.

Agents can get access to some follow up entries/functions by clicking on the links in a fare display (sample screenshot above):

- **Line number**: displays interactive flight availability for specific carrier/class
- **Fare basis**: accesses the complete fare rules
- **Currency code**: displays a dialog window to change into another currency
- **Carrier code**: decodes the carrier code
- **Fare amount**: displays penalties fare category
- **Booking class**: displays a dialog window to select other booking classes as per primary or secondary carriers, equivalent to the information supplied by the *FDC or $LB* format
- **Advanced Purchase information**: accesses the advanced purchase fare category
- **Min/Max information**: accesses the minimum and maximum fare categories
- **Season dates**: displays the seasonality fare category
- The **R** indicator: accesses the routing information as per the FR or $LR entry
- The **global indicator** code: decodes the direction of travel required for fare
- **D, DT or DT indicators**: launches the Day/Time restriction fare category

?

“Unsalable fares may exist” means that any unsalable fare for that point of sale if applicable

**Display Fare Rules from a filed fare**

First retrieve a booking

Click on the *FF (Display the Filled Fare)*

Click on the FQ1

Click on the Fare Basis - This will bring up a pop up box
Here you can search for the fare rules on the flights booked or change the information so you can search for a different Airline or a different fare if you know the Fare Basis.

Low Cost Carriers

Low Cost Carriers may be accessed via Travelport Smartpoint App™; this provides access to the same Low cost carriers available today in Focalpoint. Easyjet and Kulula are also shown via a GUI.

• EasyJet (U2) - in a GUI Window
• Jet2.com (LS) - cryptic inputs – using Travelport low cost carrier participation product (LCCP)

Note - Low cost carrier content is supported on Galileo and is available in EMEA only for customers who subscribe to LCCP subject to relevant commercial agreement, Carrier participation is subject to change.

A Galileo neutral availability request supplies low cost carrier’s information but some airlines do not show all available booking classes. Consequently, a carrier specific availability request is advisable:

A16JUNLGWBCN*U2
Tab to the flight that you require
Once the availability information is displayed, all follow-up entries under tab stops, such as fare rules and sell entries can be also clicked.

From a Booking File containing any low cost carrier segment it is possible to launch a dialog window to complete all PNR/ Booking File information in order not to forget any data to end transaction for the reservation. There is a special symbol before the carrier code $ which requires a click to open:

Where supported a series of GUI screens will be returned and the data can be populated
The low cost carrier segment that is subsequently booked will be added into the Booking File as an AK (Passive confirmed status - no message is generated if the flight is cancelled).

**Hotel Availability and Booking**

Shopping for Hotels is a lot easier using Smartpoint. Agents are not required to know the long Apollo or Galileo cryptic entries. There are three possible ways to shop for hotels.

1. **Shop using the Calendar Tool:**

2. **Click on a booked Air Segment number of a PNR/Booking File in the PNR Viewer**
   
   this option will prepopulate the data fields based on the air booking:
3. The Cryptic entry for a basic hotel availability **HOA15JUL-5NTFCO**

Smartpoint will return the hotel availability to the Terminal Window.

From the availability response, the agent can click on the rates in order to access a list of all rates for that property; the following screenshot shows its result:
Now the agent can click on any of the nightly rates in order to access to the property/rate rules page that will let us to book the room:

From here the agent can choose “sell room” to quickly sell the room (if it doesn’t require guarantee) or clicking on the “advanced sell” the following dialog window will be shown in order to proceed with the booking:
Hotel Images

By Clicking on the Blue Street name in the hotel availability you will receive hotel Images
Car Availability and Booking

The low-to-high car availability can be requested in Smartpoint via three possible ways:

1. Shop using the Calendar Tool

2. Click on a booked Air Segment number of a PNR/Booking File in the PNR Viewer. You will see a pop-up box which will populate for hotel. Click on the tab at the top of the box for “Car”. This option will prepopulate the data fields based on the air booking.
3. The Cryptic entry for a basic car availability

**CAL31MAY-04JUNFCO/ARR-1000/DT-0900**

Smartpoint will return the car availability to the Terminal Window.
Selling cars follows the same mechanics as selling hotels, Click on the rate,

However, specific sell indicators are returned by Smartpoint at the complete rules CAV environment
- **Sell Car(s):** books the car with no additional modifier
- **Advanced sell:** launches a dialog box to populate with additional modifiers:
Retrieve Booking

A list of same/similar names will be displayed if more than one PNR exists as per data entered. Any of them can be pointed and clicked to access. Once clicked, the PNR is displayed in the PNR Viewer Window.

Client PRO-files

Client File and Profile retrieval has been enhanced by Smartpoint App.

*Personal files:* Any personal file retrieved by the SLP format and any personal file retrieved by a single request with a similar name can also be pointed and clicked to access. For example **SLP/SMARTPOINT**

Clicking on the link in **GREEN**, the agent will be presented with the profile.
Agents can either move back to the previous screen or hide/show the line numbers in the profile.

**Travelscreen Preferencing**

Travelscreen Preferencing for Air, Hotel, Car, Payment, and Membership works in Travelport Smartpoint App™. Please use the Travelscreen Preferencing Manual for all Preferencing information and Travelscreen entries. Due to the nature of Travelport Smartpoint App certain entries are not supported. To sell a hotel and car with Travelscreen Preferencing you must:

1. Search for your hotel, by either entering the cryptic entry or using the search Tab or Calendar – HOA20JUNDEN
2. Click on the hotel rate-range for the property required

3. Select the rate required

4. Click on the Advanced sell
5. Click on Load Travelscreen Data
   a. The data will then load into the box
   b. Click sell room

6. Booking is confirmed with all Travelscreen Preferencing applied
For cars you would have to follow all the above steps, remembering to sell via the Advanced Sell and clicking on Load Travelscreen Data.

Please note Hotel Preferencing is for Apollo Customers only.
Splash Screen

Did you forget about Smartpoint? Once Smartpoint is installed, it is automatically launched when you open Galileo Desktop. You’re able to sign into Apollo or Galileo with your logon and password so that you can work directly in Smartpoint.

Of course, you still have the option to close Smartpoint and work in Galileo Desktop. However, we’re hoping you’ll consider all that Smartpoint has to offer so we’ve added a friendly reminder that you will see while working in Galileo Desktop.

We’ve also provided a link to give you more information about Smartpoint and to quickly open the application.

If you do not wish to see this reminder, simply check the Remind me later checkbox.
Troubleshooting

To assist when reporting any Travelport Smartpoint App™ issues please confirm the version of Smartpoint™ that is being used. Click on ‘Help’ and ‘About’ in the Help menu;

The below screen will be displayed;
The user guide can also be accessed via this menu.

### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alt+ Up Arrow</strong></td>
<td>Go back to previous interactive response from the response history.</td>
</tr>
<tr>
<td><strong>Alt+ Down Arrow</strong></td>
<td>Go to the next interactive response from the response history.</td>
</tr>
<tr>
<td><strong>ALT+S</strong></td>
<td>Stores the current window positions.</td>
</tr>
<tr>
<td><strong>Alt+ ’n’</strong></td>
<td>Move the keyboard focus to Tab 'n'. For example, ALT+1 moves to Tab\1.</td>
</tr>
<tr>
<td><strong>ALT+B</strong></td>
<td>Move to the previous interactive response (move back to previous screen).</td>
</tr>
<tr>
<td><strong>ALT+C</strong></td>
<td>Copies the Terminal content as text and for the entire host content. Example: do a HELP A and then use ALT+C.</td>
</tr>
<tr>
<td><strong>ALT+M</strong></td>
<td>Host entries like availabilities, Focalpoint shopping, etc. provide a link at the end for &quot;more&quot; results. This shortcut can be used instead of clicking on that link with the mouse.</td>
</tr>
<tr>
<td><strong>ALT+X</strong></td>
<td>If windows positions are changed but not saved, this option returns to the previous layout.</td>
</tr>
<tr>
<td><strong>ALT+D</strong></td>
<td>Changes from the upper (1) to the lower (2) Terminal Partition. If this keystroke is repeated, this sub-window is zoomed in and out.</td>
</tr>
<tr>
<td><strong>ALT+U</strong></td>
<td>Changes from the lower (2) to the upper (1) sub-window. If this keystroke is repeated, this sub-window is zoomed in and out.</td>
</tr>
<tr>
<td><strong>ALT+N</strong></td>
<td>Creates a new Tab in the current Terminal Window.</td>
</tr>
<tr>
<td><strong>ALT+R</strong></td>
<td>Removes the current Tab.</td>
</tr>
<tr>
<td><strong>ALT+C</strong></td>
<td>Copies terminal content as Text in the clipboard.</td>
</tr>
<tr>
<td><strong>ALT+H</strong></td>
<td>Goes to current terminal.</td>
</tr>
<tr>
<td><strong>ALT+W</strong></td>
<td>Shows the Next/Previous Day toolbar.</td>
</tr>
<tr>
<td><strong>ALT+E</strong></td>
<td>Hides the Next/Previous toolbar.</td>
</tr>
<tr>
<td>Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CTRL+Up Arrow</td>
<td>Repeats previous (back) entries typed by the user. Supports the last 200 entries.</td>
</tr>
<tr>
<td>CTRL+Down Arrow</td>
<td>Repeats previous entries. (forward) Supports the last 200 entries.</td>
</tr>
<tr>
<td>CTRL+Enter</td>
<td>Sends a format/entry to the host and shows the interactive response in a new Tab.</td>
</tr>
<tr>
<td>CTRL+Tab</td>
<td>Navigates through all Tabs in the current terminal window.</td>
</tr>
<tr>
<td>CTRL+F12</td>
<td>Hides/Shows Travelport Smartpoint App™ quickly.</td>
</tr>
<tr>
<td>CTRL+W</td>
<td>Clears active Terminal Partition (upper or lower).</td>
</tr>
<tr>
<td>CTRL+S</td>
<td>Clears all Terminal Partitions in the current Tab.</td>
</tr>
<tr>
<td>CTRL+C</td>
<td>Copies the selected text/data in the clipboard.</td>
</tr>
<tr>
<td>CTRL+Q</td>
<td>Moves through all Travelport Smartpoint App™ windows. Each time this shortcut is used it moves to the next window.</td>
</tr>
<tr>
<td>CTRL+M</td>
<td>Opens the Calendar widget.</td>
</tr>
<tr>
<td>CTRL+B</td>
<td>Prints current Terminal Partition content.</td>
</tr>
<tr>
<td>TAB</td>
<td>Moves the cursor to the next tab stop. Users can also click on tabbed entries.</td>
</tr>
<tr>
<td>SHIFT+TAB</td>
<td>Moves the cursor to the previous tab stop.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Moves to the top of the page.</td>
</tr>
<tr>
<td>Page down</td>
<td>Moves the cursor to the bottom of the page.</td>
</tr>
</tbody>
</table>
Quick Commands

Travelport Smartpoint App™ also comes with a Plug-in called “Quick Commands” that allows advanced users to modify a XML file that contains its definitions.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#DF</td>
<td>Direct sell flight segment</td>
</tr>
<tr>
<td>#PH</td>
<td>Passive hotel segment sell</td>
</tr>
<tr>
<td>#DH</td>
<td>Direct Hotel segment sell</td>
</tr>
<tr>
<td>#DC</td>
<td>Direct Car segment sell</td>
</tr>
<tr>
<td>#PC</td>
<td>Passive Car segment sell</td>
</tr>
<tr>
<td>#SEAT</td>
<td>Displays seat maps for the booked flights</td>
</tr>
<tr>
<td>#SEATGURU</td>
<td>Opens up seat guru web page</td>
</tr>
<tr>
<td>#TRAM</td>
<td>Launches Travelport Room and More</td>
</tr>
<tr>
<td>#VT</td>
<td>Launches View Trip for a completed PNR</td>
</tr>
<tr>
<td>#VTETR</td>
<td>Shows e-ticket via View Trip for a completed PNR</td>
</tr>
<tr>
<td>#@2</td>
<td>Change to second listed Galileo TCP/IP system settings</td>
</tr>
</tbody>
</table>
Scriptwriter Plus interaction with Focalpoint and Smartpoint

The following screens show how you can run your existing Scriptwriter Plus scripts with Smartpoint. Nearly all scripts will run as they do today in Galileo Desktop.

Note: Scripts can be launched via an icon on the Scriptwriter Run window, a tool bar icon, or a Programmable Key.

Example of how to configure the toolbar:

![Configure Toolbar]

Pkeys

Most Pkeys will work in Smartpoint, but some will not if they contain commands that are specific to the Focalpoint multi-window terminal emulation environment. For instance, a user could create a PKey that contains the command <ReDir3> which means “redirect the entry to window 3”, but this will not work in Smartpoint as Smartpoint has no concept of “window 3” (the <ReDir3> command will simply be ignored by Smartpoint, but in some cases this will lead to unexpected results.)
Scriptwriter Plus Library example running in the Focalpoint environment

This script captures information from Window 1 & 2 and displays within the Scriptwriter Plus window through the use of DDE label.

Scriptwriter Plus Library example running in the Smartpoint Window

This script captures information from Window 1 & 2 and displays within the Scriptwriter Plus window through the use of DDE label. You will see the same end result:
Bespoke Scriptwriter Plus example running in the Focalpoint Window

This script prompts the user to obtain information from Window 3 & 2 in order to complete the required fields.
Bespoke Scriptwriter Plus example running in the Smartpoint Window

This script prompts the user to obtain information from Window 3 & 2 in order to complete the required fields, however, these windows are not currently active.

The recommendation for this type of script would be to either:

- launch it in the Focalpoint Window
  OR
- modify the script to pull the data from the Focalpoint window into a DDE label and display it within the script (see example which follows)
Note: Scriptwriter Plus “Build” requires a 32bit Windows session. It is not necessary to have ‘build’ loaded on every workstation, only those who need to create or modify scripts.